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Introduction	
This	document	outlines	a	timeline	and	defines	the	roles	of	departments	(exams	office	and	IT	
support)	and	individuals	(teacher,	student,	administrative	officers)	in	organising	and	running	e-
Exams	based	on	a	centralised	examinations	office	model.	Advice	for	IT	support	staffing	and	setting	
up	exam	venues	with	power	cables	is	provided.	

Background	

As	education	increasingly	uses	information	technology,	students	are	uncomfortable	with	the	
disjunction	between	learning	online	and	protracted	hand-written	examination	assessment.	Yet	in	
the	digital	age,	it	is	also	difficult	to	authoritatively	attribute	authorship	for	non-supervised	
assessment	such	as	word-processed	assignments.	The	use	of	sophisticated	software	applications	
in	non-supervised	assessments	(projects	and	assignments)	contrasts	greatly	to	pen-on-paper	
commonly	used	in	supervised	examinations	in	terms	of	allowing	assessors	to	set	complex,	
authentic	problems	and	for	students	to	demonstrate	their	best	when	employing	contemporary	e-
tools	of	the	trade.	An	e-Exam	allows	relevant,	sophisticated,	modern	software	tools	and	the	
integrity	of	a	well	run	supervised	examination	to	be	bought	together.	

The	e-Exam	System	allows	candidates	to	use	their	own	personal	computer	just	as	they	have	
previously	used	their	own	writing	implements	in	examinations.	These	computers	are	started	up	
(booted)	from	a	special	e-Exam	USB	stick	for	Windows	PCs	and	Apple	Macintosh	platforms.	The	e-
Exam	USB	contains	an	operating	system	based	on	Ubuntu	(a	Linux-based	operating	system)	'e-
Exam	OS'	and	a	set	of	software	applications.	As	such	all	exam	candidates	will	be	using	the	
alternative	operating	system	'e-Exam	OS'	on	their	computer	instead	of	their	regular	Windows	or	
Apple	software.	The	e-Exam	operating	system	'locks	down'	the	computer	by	interdicting	all	
communications	and	local	disk	access	to	ensure	each	candidate	the	same	opportunity	of	
demonstrating	achievement	within	a	controlled	software	environment.	To	help	exam	invigilators	
the	system	displays	a	unique	desktop	image	for	non-technical	staff	to	easily	verify	the	correct	
exam	and	system	is	in	use.	The	process	of	using	an	e-Exam	USB	leaves	student's	computer	
completely	untouched	and	as	such	does	not	write,	change	or	delete	any	data	on	their	personal	
hard	drive.	

e-Exam	use	at	UTAS	

The	University	Teaching	&	Learning	Committee	received	the	final	report	on	the	e-Examinations	
Project,	led	by	Dr	Andrew	Fluck,	Faculty	of	Education,	on	4th	March	2011.	Trial	e-Examinations	
had	been	introduced	into	the	Faculty	of	Education	in	2006,	making	national	headlines	in	2009.	In	
2010,	the	e-Exam	System	was	used	successfully	in	the	UTAS	Faculties	of	Law,	Arts	and	Education	
on	the	Cradle	Coast	and	Launceston	campuses	with	cohorts	of	up	to	89	candidates.	Academic	
Senate	endorsed	the	use	of	e-Examinations	and	recommended	that	Heads	of	School	and	Unit	
Coordinators	consider	where	these	are	deployed	and	how	students	are	to	be	advised.	The	e-Exam	
System	has	been	in	use	at	the	University	of	Tasmania	since	then,	sometimes	in	non-formal	
settings.	

Thanks	are	extended	to	those	kind	members	of	staff	who	have	commented	on	this	manual	and	
thus	improved	it.	

The	software	is	available	under	an	open	source	licence	from	the	AARNET	Mirror	at	
http://mirror.aarnet.edu.au/pub/e-Exams.		

Further	reading	
The	following	articles	outline	the	rationale	and	progress	on	the	development	of	e-Exams.	

Fluck	A,	&	Hillier,	M.	(2016)	Innovative	assessment	with	e-Exams.	Australian	Council	for	Computers	in	
Education	Conference,	Brisbane,	29	Sep	to	2	Oct.	Available	
http://conference.acce.edu.au/index.php/acce/acce2016/paper/view/34/27		
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Fluck,	A,	(2009)	Towards	Transformation:	e-Examinations	for	ICT-enabled	Learning	Outcomes.	Education	
and	Technology	for	a	Better	World,	27-31	July	2009,	Brazil,	pp.	1-10.	Available	
http://www.ifip.org/wcce2009/proceedings/papers/WCCE2009_pap44.pdf		

Fluck,	A.,	Pullen,	D.L.	and	Harper,	C.	(2009)	Case	study	of	a	computer	based	examination	system.	
Australasian	Journal	of	Educational	Technology,	25	(4)	pp.	509-523.	Available	
http://www.ascilite.org.au/ajet/ajet25/fluck.pdf		

Fluck,	A,	‘Can	Tertiary	eAssessment	change	secondary	school	cultures?’,	Proceedings	of	the	Computer	Aided	
Assessment	Conference	on	10th	&	11th	July	2007	at	Loughborough	University,	10-11	July	2007,	
Loughborough	University,	pp.	191-206.	Available	https://dspace.lboro.ac.uk/dspace-
jspui/bitstream/2134/4544/1/Fluck%20A.pdf		
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Timeline	and	roles	for	running	an	e-Exam	
The	following	outlines	an	example	timeline	and	duties	(roles)	for	teaching	and	administration	staff	
in	relation	to	preparing	for	an	e-Exam.	The	procedures	are	not	inclusive	of	all	examinations	
management	activity	but	instead	focus	on	those	elements	relevant	to	e-Exams.	These	procedures	
will	need	to	be	adjusted	to	suit	your	local	institutional	context.	The	suggested	procedures	and	
timeline	are	outlined	as	used	by	the	University	of	Tasmania	based	on	examinations	being	
organised	and	invigilated	in	centrally	managed	exam	venues.		This	example	is	for	an	off-line	word	
document	mode	exam.	

Before	semester	starts	
Planning	

Unit	coordinator	decides	to	make	e-Exam	available	to	candidates.	

Consider	if	typing	will	be	mandatory	for	all,	or	an	option?	What	are	the	
criteria	if	the	latter?	A	common	instruction	to	students	is	to	“choose	the	
writing	tool	you	consider	will	give	you	the	best	advantage.”	
You	need	to:	
• Consult	the	Exams	Office	to	confirm	with	Information	Technology	Services	

the	feasibility	of	running	an	e-Exam	for	your	unit.		
• You	need	the	agreement	of	the	Head	of	School	and	a	defined	method	of	

offering	an	alternative	to	students.	
• Include	mention	of	the	e-Exam	in	the	Course	and	Unit	handbook	

description	of	the	unit.	

Unit	
coordinator	

Unit	outline	

Unit	coordinator	needs	to	add	following	text	into	the	unit	outline	or	synopsis	
adjacent	the	relevant	assessment	task.	Add	or	remove	elements	in	<braces>	
as	applicable.	

This	assessment	will	be	offered	as	an	e-Exam.	The	e-Exam	will	be	
<compulsory><optional>	for	students.	

You	will	need	a	laptop	computer	which	can	boot	from	a	USB	stick	for	
the	examination.	The	laptop	will	require	a	minimum	10"	screen,	at	
least	2GB	of	RAM	and	an	Intel	processor.	<The	e-Exam	will	include	
multimedia	therefore	a	set	of	earphone	will	be	required>.	You	may	
also	bring	a	wired	mouse.		You	must	bring	the	mains	power	adapter.	

You	will	need	to	obtain	e-Exam	Certificate	for	the	laptop.	You	will	not	
be	permitted	to	start	up	your	computer	at	the	venue	without	the	e-
Exam	Certificate.	To	obtain	this	certificate	students	will	need	to	test	
that	their	laptop	will	work	with	the	e-Exam	system.	To	do	so	students	
can	create	a	practice	e-Exam	system	by	downloading	the	e-Exam	
practice	software	and	then	writing	the	system	to	an	empty	USB	with	a	
minimum	capacity	of	8GB	(note	this	process	will	overwrite	any	data	
already	on	the	stick).	Please	refer	to	the	e-Exam	section	of	the	
University	website	for	details	on	how	to	get	ready	for	the	e-Exam	
http://www.utas.edu.au/exams/e-Exams/e-Exams-for-students.	

Unit	
coordinator	
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Week	1	
Informing	students	

Discuss	e-Exams	with	students	providing	an	outline	of	the	exam	conditions,	
dates,	practice	session	times	(if	applicable),	how	the	process	works	and	the	
requirements	for	suitable	laptop	(as	per	the	course	information).	

Advise	students	that	they	are	expected	to	be	familiar	with	general	user	
functions	within	the	e-Exam	system	software	with	respect	to	using	the	e-Exam	
system	with	their	laptop	and	to	achieve	the	workflow	required	for	the	type	of	
exam	they	will	be	undertaking.	Be	sure	to	explain	these	requirements	(e.g.		
offline	word	document,	or	spreadsheet	or	online	via	an	LMS	etc).		

Point	students	to	the	self-help	resources	provided	by	the	university	(or	the	
more	generic	'Prep	and	Practice	Guide'	from	TransformingExams.com).	

Advise	students	that	they	will	need	to:	

1. Obtain	an	8GB	or	larger	USB	stick.	
2. Download	their	own	practice	e-Exam	(system	disk	image	file)		
3. Create	their	own	e-Exam	USB	(burn	image	to	USB).	
4. Undertake	the	student	e-Exam	certification	process	with	the	laptop	

they	intend	to	use	for	the	e-Exam.	

Lecturer/	Tutor	

Week	4	(exam	file	due	date)	
The	exams	file	

Exams	File	is	sent	to	the	UTAS	Exams	Office.	Include	the	following	codes:	

• Materials	Allowed:	LA	–	a	laptop	computer	with	at	least	2GB	RAM	and	an	
Intel	processor	for	the	e-Examination	with	the	appropriate	mains	
adapter/charger,	a	wired	mouse	and	headphones.		

• Materials	Provided:	US	-	USB	Drive	containing	the	e-Exam	System,	exam	
materials	and	space	for	answer	script.	

Unit	
coordinator	&	
Course	support	
officer	
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About	week	7	
Preparation	of	e-Exam	question	paper		

Write	your	exam	paper	in	the	normal	way.	

Create	a	second	copy	of	the	exam	paper	file	(in	WORD	format)	with	these	
changes:	

a)	At	the	top	of	the	first	page	insert	this	material:	

	 Questions:	nn	

Type	your	ID	number	here:	 Pages:	e-Exam	

	

	

b)	After	each	question	or	part-question,	insert	this	line	where	you	want	a	
response:	

Please	write	your	answer	below	this	line																																																							

 

 

Note:	the	two	lines	underneath	should	be	in	a	different	font	to	that	used	for	
the	questions	themselves.	Typically	questions	will	be	in	Times New Roman 
(like this) and	therefore	answers should appear in Arial. Font size for 
answers should appear somewhat bigger than that for questions (like 
this). Alternatively, dark blue text can be used.	

Unit	
coordinator	

About	week	10	
Practice	e-Exam	

Encourage	students	to	visit	the	university	e-Exams	website	and	follow	the	
instructions	to	create	a	practice	e-Exam,	verify	operation	on	their	own	
computer,	and	print	their	e-Exam	Certificate.	They	will	not	be	allowed	to	start	
up	their	computer	in	the	exam	venue	without	this	certificate.	

Unit	
coordinator	

Submission	of	exam	question	paper	

Provide	the	following	to	the	Exams	Office	via	the	InSite	secure	database:	

a)	The	question	paper	in	WORD	format	as	described	above	in	Preparation	of	
e-Exam	question	paper.	If	additional	digital	data	will	be	provided	to	students,	
then	this	should	be	placed	in	a	folder	called	‘Materials’	and	zipped	up	with	the	
WORD	document.	Name	this	ABC-s-20yy-e-Exam.zip.	

b)	an	equivalent	PDF	question	paper	(even	if	the	e-Exam	is	mandatory,	this	
will	be	used	as	a	backup).	

c)	A	digital	photograph	of	your	choice	to	be	used	as	a	security	image	on	the	
desktop	background.		

d)	An	estimate	of	the	number	of	students	expecting	to	use	a	computer	for	the	
exam	at	each	venue.	

Unit	
coordinator	&	
Course	support	
officer	
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Exams	Office	to	identify	campus	sittings,	and	commence	negotiations	with	
interstate	distance	examination	centres	to	assess	feasibility	of	distance	
sittings.			

Exams	Office	

For	isolated	students	(i.e.	students	who	are	not	sitting	an	exam	at	one	of	our	
approved	partner	institutes	-	see	
https://forms.afp.utas.edu.au/distantexamination.html,	students	will	need	to	
negotiate	feasibility	of	e-Exam	directly	with	nominated	venue.	

Some	students	

	

Week	11	
USB	creation	

Create	a	Master	USB	for	the	e-Exam	using:	

a)	ITS	internal	manual	for	e-Exam	operations	(PDF	7.3MB)	
OR	
b)	The	e-Exam	Admin	Tool	USB	provided	(see	'Admin	tool	guide'	
documentation	at	http://www.transformingexams.com/guides.html)	

ITS	staff	working	
under	secure	
conditions	for	
Exams	Office		

Duplicate	enough	e-Exam	USBs	to	serve	all	the	students	expected	to	require	
them,	plus	an	extra	10%	per	venue.	To	do	the	duplication:	

a)	Use	NexCopy	job	CopyDevice-Dtoall-ShortImageV.ini	This	will	verify	the	
data	-	dongle	required.		
OR		
b)	e-Exam	Administration	tool.	Using	the	'Duplicate	USBs'	function	or	the	
procedures	to	'recycle'	USBs	(See	Admin	tool	guide).	

Verify	operation	of	one	USB	in	each	batch	(and	re-write	this	test	USB).	

ITS	staff	working	
under	secure	
conditions	for	
Exams	Office	

Distribute	e-Exam	USBs	to	venues	with	sufficient	copies	of	the	e-Exam	
Candidate	Instructions	[see	Appendix]	to	examinations	centres.	The	latter	can	
be	laminated	and	re-used.	

Exams	Office		

The	day	prior	to	e-Exam:	venue	set-up	
Venue	set	up:	

Deploy	sufficient	mains	electricity	extension	cables	and	multi-way	adapters	
for	each	e-Exam	candidate	to	access	a	(filtered)	power	socket	at	their	seat.		

See	the	section	'Power	layout	in	exam	halls'	for	further	information	on	layouts	
to	minimise	trip	hazards	and	maximise	access.	

Staffing	IT	support:	

See	the	section	'IT	staffing	levels	in	exam	halls'	for	suggested	ratios	of	IT	staff	
for	set-up	and	support	during	e-Exam	events.	

ITS	staff	working	
for	Exams	Office	

Exam	day:	at	least	60	mins	before	start	
Attend	the	exam	venue	with	your	laptop,	e-Exam	Certificate,	and	mains	
power	adapter,	wired	mouse	(no	wireless	devices	permitted)	and	headphones	
(please	note	that	headphones	cannot	be	'smart'	devices).	

Students	
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Exam	day:	15	mins	before	start	
Distribute	a	USB	drive	and	the	"e-Exam	Candidate	Instructions"	to	each	e-
Exam	candidate	desk.	Note	you	have	a	printout	of	the	reference	security	
image	to	compare	against	student	desktops	when	they	start	up	their	
computers.		

Exam	
supervisors	

Exam	day:	commencement	of	exam	
Immediately	on	entry	of	students,	those	undertaking	an	e-Exam	are	directed	
to	the	designated	e-Exam	area.		On	arrival	at	their	desk,	Exam	Supervisors	will	
check	each	student’s	e-Exam	Certificate.		When	students	have	been	checked	
they	can	plug	in	their	computers	and	start	up.	ITS	to	undertake	standard	
assistance	if	required.	

Refer	to	the	'announcements	to	candidates'	section	for	a	script	of	
announcements	for	mixed	e-Exam	sessions.	

Exam	
supervisors	

&	ITS	officers	

Attend	the	first	15	minutes	of	the	e-Exam	as	you	would	normally,	liaising	with	
supervisors	if	clarification	of	questions	is	needed.	

Unit	
coordinator	

Exam	start	time	
Run	the	exam	as	normal.	See	the	section	"Announcements	to	candidates"	for	
a	script	of	announcements	suited	to	mixed	e-Exam	and	handwritten	venues.		

Exam	
supervisors	

During	exam	
As	you	check	candidate	ID	cards,	record	the	number	on	each	USB	stick	against	
their	name	on	the	attendance	roll.	

Exam	
supervisors	

At	end	of	exam	
Write	your	ID	number	on	the	labelled	plastic	bag	and	sign	it.	After	shutting	
down	your	computer,	place	the	e-Exam	USB	into	the	bag	and	seal	it.	

Students	

Treatment	of	answer	scripts:	

Collect	and	acquit	USB	sticks	as	if	they	were	Answer	booklets.		

Exam	
supervisors	

Post-exam	
Return	all	other	materials,	USBs	and	papers	to	the	Exams	Office	in	the	normal	
way.	

Exam	
supervisors	

Collected	e-Exam	USBs	are	to	be	couriered	to	the	unit	Exams	Office	marking	
location.	

Exams	Office	

Use	the	USB	duplicator	to	collect	all	the	contents	of	the	Answer	partitions.	
Use:	
a)	NextCopy	Collect-Answer-Scripts.ini.	OR		
b)	e-Exam	Administration	tool	to	'retrieve	responses	from	USBs'	(See	Admin	
tool	guide).	
Place	all	files	into	a	single	folder	named	with	the	unit	code	for	the	exam.	If	
possible/appropriate,	provide	sub-folders	with:	

• The	date	of	the	exam	
• Exam	venue/campus	location	

IT	officers	
working	for	the	
Exams	Office	

Return	all	answer	booklets	and	a	copy	of	the	digital	answer	script	folder	to	the	
unit	co-ordinator	in	the	normal	way.	The	USB	sticks	may	be	needed	for	
another	exam,	but	until	then	hold	them	separately.	

Exams	Office	
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Marking	

Collect	answer	script	papers	and	files	from	the	Exams	Office.	Mark	these	as	
normal	–	the	digital	files	can	be	marked	on	screen	or	printed.		

Unit	
coordinator	

	

Power	layout	in	exam	halls	
It	is	recommended	that	the	day	prior	to	the	exam	event	that	power	cables	and	sockets	be	set	up	
in	venues.	Power	sockets	should	be	provided	to	each	student	seat	or	pair	of	seats.	Using	
extension	cables	and	multi-socket	power	boards/blocks	can	be	used.		

It	is	important	that	power	cables	be	laid	in	a	manner	as	to	maintain	safety	for	staff	and	students	
and	avoid	trip	hazards.		

Exam	invigilators	and	staff	must	be	able	to	access	every	candidate	without	treading	on	wires.	

Where	exam	desks	are	arranged	in	rows	and	columns.	The	recommended	power	cable	layout	is	to	
use	alternate	columns	(or	alternate	rows)	for	laying	power	cables.	That	leaves	every	other	row	for	
person	circulation.	This	layout	allows	invigilator	access	to	each	student	while	avoiding	trip	
hazards.	

See	diagram	and	example	image	below.	

						 	

Recommended	IT	support	staffing	in	exam	halls	
It	is	recommended	IT	support	staff	be	on	hand	at	exam	venues.		

Level	1	IT	support	officers	is	all	that	are	required	in	most	cases.	The	most	common	issues	
encountered	relate	to	starting	up	(booting)	laptops	from	an	e-Exam	USB	(a	Live	Linux	USB	stick).	
In	the	cases	on	networked	e-Exams	this	may	also	include	connecting	to	networks	(WiFi).	
Familiarisation	with	the	e-Exam	operating	system,	utilities	and	applications	is	required	but	is	
much	less	frequently	called	upon	(e.g.	adjust	screen	resolutions,	sound,	reconnect	WiFi).	Students	
are	expected	to	be	familiar	with	general	user	functions	within	software	with	respect	to	using	the	
e-Exam	system	with	their	laptop	and	to	achieve	the	workflow	required	for	the	type	of	exam	they	
will	be	undertaking	on	the	day.	

It	is	expected	the	e-Exam	system	USBs	and	servers	(where	applicable)	will	be	established	and	
tested	well	before	the	exam	session.	

The	table	below	outlines	the	recommended	IT	support	staffing	ratios	at	each	stage	of	an	e-Exam	
session	used	by	University	of	Tasmania.	The	example	is	for	non-networked	(fully	offline)	e-Exams.	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	

	 	



	
	

	

Organising	e-Exams	Guide	–	e-Exam	System	v6	 	 	
	

9	

These	rations	may	need	to	be	adjusted	for	early	stage	e-Exams	sessions	where	e-Exams	are	first	
being	introduced	within	the	institution.	

Large	venues	should	be	prepared	the	day	before	the	e-Exam	session	(if	possible)	to	reduce	the	
need	for	contingency	requirements.	

IT	Services	e-Exam	Support	Requirements	per	100	candidates	

	 BUMP	In	and	Out		
A	once	only	task	per	3-week	exam	
period	i.e.	covers	all	e-Exams	at	a	
venue.	
-	Lay	power	cables	in	segregated	aisles.	

Boot-Phase	
-	10	minutes	prior	to	
e-Exam	start.	
-	20	minutes	following	
e-Exam	start.	

During	e-Exam*	

-	escalation	
only.	

IT	Staffing	
at	venue	

2	x	IT	staff	for	30	minutes	(unless	Bump	
In	or	Out	is	scheduled	during	a	short	
lunch	break,	then	6	x	IT	staff	may	be	
required).	

1	x	IT	staff	for	30	
minutes.	

None	(on	call).	

	

*	During	early	stage	e-Exams	(initial	pilots	and	early	introduction)	it	is	recommended	that	a	single	
IT	staff	member	be	present	for	the	duration	of	the	e-Exam.	

	

Note:		

IT	officers	need	to	be	briefed	as	to	the	protocols	of	working	in	an	exam	room	space.	This	includes	
speaking	in	a	low	voice,	having	phones	on	silent	(or	flight	mode	if	possible)	and	quiet	and	
unobtrusive	movement	(not	bumping	desks).	
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Announcements	to	candidates	
The	following	provides	an	example	of	a	run	sheet	and	announcements	that	a	head	examination	
invigilator	(supervisor)	will	make	during	the	course	of	an	exam	session.	This	example	was	used	in	
cases	where	e-Exam	and	handwriting	candidates	were	in	the	same	venue.	

Announcements	to	Candidates	
Concurrent	e-Exam	and	Paper	Exam	

Arrange	the	examination	area	so	that	all	students	requiring	access	to	mains	power	will	be	able	

to	plug	into	a	socket.		IT	Support	Officers	will	ensure	cabling	is	laid	with	multi-port	outlets	so	all	

students	have	access	to	mains	power.		You	will	have	dedicated	lanes	free	of	wires	to	access	

every	candidate	desk.	

Distribute	to	each	student	desk:	

1)	an	individually	numbered	USB.	

2)	a	copy	of	the	e-Exam	Candidate	Instructions.			

DO	NOT	distribute	any	printed	copies	of	the	security	image	to	students.	

All	students	should	be	admitted	15	minutes	prior	to	the	start	of	the	examination.			

e-Exam	candidates	bringing	a	laptop	must	produce	their	e-Exam	Certificate	before	they	sit	down	

or	plug	in	their	computer,	and	should	be	instructed	as	follows:		

1. Follow	 the	 e-Exam	Candidate	 Instructions.	 STOP	 and	WAIT	when	 you	 see	 a	 prompt	 for	
your	ID	number.		

Check	that	every	e-Exam	participant	computer	desktop	displays	the	security	image.		You	will	

have	been	provided	with	a	printed	copy	of	this	image,	which	is	not	to	be	given	to	candidates.	

	
When	all	candidates	are	seated,	the	following	announcements	should	be	made:	

2. Place	 your	 current	 ID	 card	 on	 the	 right-hand	 side	 of	 the	 desk.	 	 All	 students	 without	 a	
current	 identity	 card	 please	 raise	 your	 hand	 –	 you	will	 now	 need	 to	 go	 to	 the	 Student	
Centre	 for	 your	 replacement	 card.	 (UTAS	 Distance/Online	 students	 please	 provide	
another	form	of	photo	ID).	

3. Today	we	will	be	running	an	e-Exam	[trial].		

4. Please	 note	 that	 mobile	 phones	 and	 smart	 devices,	 including	 smart	 watches,	 are	 now	
banned	 in	 all	 University	 of	 Tasmania	 examination	 venues.	 Penalties	 apply	 for	 bringing	
mobile	phones	or	smart	devices	to	an	exam	venue.	If	you	have	a	mobile	phone	or	smart	
device	 in	 your	 possession,	 please	 raise	 your	 hand	 now.	 This	 is	 the	 only	 opportunity	 to	
depart	the	venue	and	remove	the	unauthorised	device.	Again,	please	raise	your	hand	now	
if	you	have	a	mobile	phone	or	smart	device	on	you.	

5. Please	 check	 that	 you	 have	 no	 unauthorised	 material	 in	 your	 possession.	 Any	
unauthorised	 material	 found	 after	 the	 examination	 starts	 will	 be	 regarded	 as	 possible	
evidence	of	cheating	or	attempting	to	do	so.	Please	hand	any	unauthorised	material	to	a	
supervisor	now.	

6. Students	may	not	 leave	the	examination	room	until	30	minutes	after	the	end	of	reading	
time,	and	may	not	leave	during	the	last	15	minutes	of	the	examination.	

7. For	those	following	a	paper-based	exam,	you	should	write	on	both	sides	of	the	page.		Any	
page	may	be	used	for	rough	work.	Just	draw	a	diagonal	line	through	that	page	to	indicate	
that	 it	 is	not	part	of	 an	answer.	Books	will	 not	be	 issued	 for	 rough	work,	 and	no	pages	
should	be	removed	from	books	or	question	papers.		All	question	papers	must	be	handed	
in.	
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8. If	 you	 wish	 to	 leave	 the	 room	 early	 or	 require	 the	 assistance	 of	 a	 supervisor	 or	 an	 IT	
Support	 Officer,	 please	 raise	 your	 hand.	 I	 will	 give	 you	 a	 15	 minute	 warning	 before	
finishing	time.	

9. For	those	completing	a	paper	based	exam,	you	may	go	ahead	and	fill	in	the	cover	of	your	
question	paper	and	answer	books.	 	 If	you	have	to	alter	your	student	 ID	number	 for	any	
reason,	 please	 raise	 your	 hand,	 and	 a	 supervisor	will	 check	 and	 initial	 the	 alteration.	 If	
your	exam	allows	a	calculator,	write	the	brand	and	model	in	the	space	provided.		

16	minutes	prior	to	the	start	of	exam	writing:	

10. We	are	about	 to	begin	 the	15	Minutes	of	Reading	Time.	 	 For	 those	completing	a	paper	
based	 exam,	 you	 may	 write	 on	 your	 question	 paper	 and	 answer	 book	 during	 Reading	
Time.		For	those	completing	an	e-Exam,	you	can	enter	your	ID	number	and	click	on	‘Start	
Exam’.				

11. Your	reading	time	starts	now.	

Note	the	start	of	reading	time	on	the	display	board.	Patrol	the	room	until	15	minutes	have	

passed.			

Ask	the	IT	Support	Officers	to	assist	any	students	having	difficulties.	Record	any	difficulties	

encountered.	

12. I	will	give	you	a	15	minute	warning	before	finishing	time:	
The	2	hour	exam	will	finish	at	3.15pm	[and	the	3	hour	exam	will	finish	at	4.15pm.]		
Your	examination	writing/typing	time	officially	starts	no	

During	the	exam,	patrol	the	room	as	normal.	Students	are	permitted	a	wired	mouse	and	

earphones	[not	'smart'	ones],	but	are	not	permitted	any	other	digital	materials	in	the	e-Exam,	

so	any	foreign	USB	sticks	or	digital	devices	are	not	allowed.		Deal	with	instances	as	per	the	

normal	regulations	if	a	candidate	is	found	to	have	unauthorised	material.		Ask	an	IT	Support	

Officer	to	verify	any	item	of	which	you	are	uncertain.		

	

When	there	are	15	minutes	remaining,	advise	the	students:	

13. You	have	15	minutes	remaining.	For	those	completing	an	e-Exam,	you	will	need	to	check	
your	file	is	in	the	ANSWERS	partition	of	the	USB	stick	at	the	end	of	the	examination.			

When	there	are	5	minutes	remaining,	advise	the	students:	

14. You	have	5	minutes	remaining.		For	those	completing	an	e-Exam,	you	will	need	to	check	
your	file	is	in	the	ANSWERS	partition	of	the	USB	stick	at	the	end	of	the	examination.			

At	the	end	of	the	examination,	advise	the	students:	

15. Please	 stop	 work	 now.	 	 For	 those	 completing	 an	 e-Exam,	 close	 all	 applications.	 If	 you	
require	an	IT	Support	Officer	to	verify	your	file	is	saved	properly,	raise	your	hand	and	wait	
patiently.			

Allow	the	IT	Support	Officers	to	validate	any	files.				

16. For	those	completing	a	paper-based	exam,	place	your	question	paper,	notes,	graphs	and	
any	follow	on	books	inside	the	cover	of	your	first	answer	book.			

17. Please	 remain	 seated	and	no	 talking	until	 all	books	and	USBs	are	 collected	and	you	are	
asked	to	leave.		

When	all	e-Exam	queries	have	been	addressed,	advise	the	students:	

18. For	 those	 completing	 an	 e-Exam,	 shut	 down	 your	 computers.	 	When	 this	 is	 completed,	
remove	the	USB	sticks	which	will	be	collected.			
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When	all	books	and	USB	sticks	are	collected,	ask	if	anyone	has	a	question	paper,	graph,	notes	or	

answer	book	left	on	your	desk.	Advise	students:	

19. Thank	 you.	 	 You	may	 receive	 an	 invitation	 to	 undertake	 a	 short	 survey	 in	 the	 next	 few	
days	and	we	would	appreciate	your	assistance	with	 this	process.	 	We	have	a	 survey	 for	
both	e-Exam	participants,	and	for	students	following	an	ordinary	paper	based	exam.		Your	
contribution	to	the	survey	is	highly	valued.	All	students	may	leave	the	room.	

Technical	problems	

A	candidate	experiencing	technical	problems	should	be	directed	to	an	IT	Support	Officer.		The	

candidate	may	subsequently	request	a	printed	question	paper	and	answer	booklet,	which	

should	be	collected	at	the	end.		Any	period	taken	to	rectify	a	technical	problem	should	be	added	

to	the	candidate’s	total	examination	time.		Evidence	of	this	will	be	a	signed	note	from	the	IT	

Support	Officer	attesting	to	the	extra	time	required.	

	

Late	arrivals	

Candidates	arriving	30	minutes	or	more	after	the	commencement	of	the	examination	writing	

time	shall	not	be	admitted.	

	

Early	finishers	

Candidates	may	not	leave	in	the	last	15	minutes	of	writing	time.		Those	who	finish	earlier	will	

need	to	have	their	USB	stick	collected.			
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FAQs	on	exam	procedure	for	students	
Most	e-Exams	are	comfortable	and	convenient,	but	here	is	how	to	cope….	

	 Student	activity	 Mitigation	procedure	

B
ef
or
e	
th
e	
e-
Ex
am

	

	 The	certification	package	can	be	downloaded	from	the	
AARNET	mirror	or	the	UTAS	web-sites.	It’s	fast	and	
without	cost	on	campus.	Attempt	the	download	at	
least	once,	but	no	more	than	three	times.	

If	you	cannot	download	this	package	at	least	a	month	
before	your	e-Exam,	post	a	good	quality	USB	covered	
in	a	piece	of	bubblewrap	in	a	Tough	Bag	to	the	unit	
coordinator	with	a	stamped,	self-addressed	Tough	
Bag.	A	practice	e-Exam	USB	will	be	returned	to	you.	

	 Access	the	help	guides	on	the	UTAS	web-site	or	at	
transformingexams.com.	If	nothing	works,	your	
computer	may	be	incompatible	and	you	will	have	to	
handwrite	answers	from	the	printed	version	of	the	
question	paper.	You	may	elect	to	borrow	a	different	
latop,	but	it	must	be	certified	as	well.	

	 Just	re-boot	your	laptop	again.	The	e-Exam	System	
autosaves	every	2	minutes,	so	you’ll	be	able	to	carry	
straight	on.	

D
ur
in
g	
th
e	
e-
Ex
am

	

	 	

The	exam	hasn’t	started	yet,	so	don’t	panic.	Raise	
your	hand	and	an	IT	officer	will	assist.	

	 Raise	your	hand	and	get	a	spare	USB	and	try	again.	Or	
you	can	ask	for	printed	copy	of	the	exam	questions	
from	a	supervisor	and	elect	to	handwrite	your	
answers.	

	 Raise	your	hand	and	get	the	written	form	of	the	exam	
questions,	then	handwrite	your	remaining	answers.	
Hand	in	both	the	USB	AND	the	answer	booklet.	

A
ft
er
	

	
Follow	the	normal	procedures	to	request	a	review	and	
a	chance	to	view	your	answers.	A	printout	of	your	e-
Exam	responses	will	be	made	available,	with	a	chance	
to	view	the	files	which	were	assessed.	

	

I’m	trying	to	boot	my	
computer	from	the	practice	e-
Exam	USB,	but	it’s	not	
working.	

I	got	the	practice	e-Exam	USB	
booted	up,	but	something	
froze	up	halfway	through.	

I	can’t	get	my	computer	to	
boot	up	from	the	e-Exam	USB,	
even	though	I	practiced	this	
before!	

My	computer	still	won’t	start	
up	properly	OR	they	forgot	to	
give	me	a	USB	stick!	

I	got	started	and	went	really	
well.	Then	my	computer	
crashed	and	I	can’t	get	it	to	go	
again…	

I	didn’t	get	the	result	I	
expected	in	the	exam	–	how	
can	I	review	the	paper?	

My	unit	coordinator	says	I	
can	use	my	computer	in	the	
exam!	

I	just	need	to	certify	my	
laptop	and	my	own	skills.	But	
I	can’t	download	the	
certification	package	to	make	
a	practice	e-Exam	USB.	
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eExam	Candidate	Instructions	
Before	you	arrive	
• Your	computer	must	be	completely	shut	down	(not	sleeping:	SHIFT>Shutdown	on	Win10).		

When	you	reach	your	seat	
• Show	your	eExam	Certificate	to	the	Supervisor.	
• Position	your	computer	and	connect	the	power	adapter	if	required.	

Before	start	up…	the	computer	must	be	OFF	(shut	down)	
The	e-Exam	system	should	now	start	…	

Note:	the	screen	may	flicker	and	messages	may	appear.	On	some	
computers	it	may	take	a	minute	or	two	to	load.	

e-Exam	desktop	
When	the	computer	is	ready	you	will	see:		

• A	photograph	as	the	desktop	background.	
• A	request	for	your	student	ID	number	.	

	
A	supervisor	will	now	check	screens.	Raise	your	hand	if	you	
experience	technical	difficulties.		
Continue	only	when	instructed…	

1. Type	your	student	ID	number	into	the	box,	then	
2. Click	"Start	Exam"	

The	question	paper	should	now	open,	ready	for	your	responses.		
1. Type	your	details	into	the	space(s)	indicated	on	the	first	page	
2. Follow	the	instructions	specific	to	your	exam.	
3. Type	your	answers	into	the	spaces	indicated.	

Important!	Remember	to	use	File	>	Save	at	regular	intervals.	
Note:	an	'auto	recovery'	save	occurs	every	2	minutes.	

When	you	are	finished	writing	
1. Use	File	>	Save	to	ensure	everything	is	saved.	
2. Use	File	>	Exit	LibreOffice	to	close	the	word	processor.	

It	is	your	responsibility	to	ensure	your	answers	are	properly	saved	
into	the	'Answers'	area	–	Click	the	"Answers"	button	and	check	the	
file	is	correctly	saved	with	your	student	ID	prefixed	to	the	file	name.		
Ask	a	supervisor	if	in	doubt!	

When	you	are	ready	to	submit	your	exam	
1. Shut	down	your	computer	using	the	red	"Shut	Down"	button	

in	the	left-side	menu	bar.		
2. Remove	the	USB	stick	from	your	computer.	

Follow	the	directions	given	by	the	supervisor	to:	
a) Wait	and	hand	back	the	USB	stick	OR	
b)	 Leave	it	on	the	desk.	

NOTE:	Time	credit	will	be	granted	for	any	technical	support	issues,	no	
candidate	will	be	disadvantaged	through	problems	with	eExam	equipment.	
	 	 	

Windows:	List	of	
One	Time	Boot	Keys	
	 See	the	reverse	side		

Apple#	laptops	
1. Insert	e-Exam	System	USB	stick.	
2. Power	ON	while	holding	down	the	

Alt/option	key...	keep	holding	Alt.	
3. Use	arrow	keys	to	select		

Yellow	'EFI'	icon.		
4. Press	the	[Enter]	key	to	choose	it.		

Windows*	laptops		
1. Insert	e-Exam	System	USB	stick.	
2. Power	ON	and	repeatedly	tap	the	'one-time	boot	key'	(see	list	overleaf).	
3. Keep	tapping	the	one-time	boot	key	until	the	boot	menu	appears.	
4. Select	the	USB	device	-	use	arrow	keys	to	choose.		
5. Press	the	[Enter]	key	to	choose	it.		
*	Note	some	Win8/10	laptops	require	SHIFT	>	Restart	to	select	USB	to	boot.	

Example	desktop:	yours	will	vary	

	
Retina	/	Hi	Def	Screen	–	tiny	text?	
	
Dash	Home	 	>	type	"Displays"	>	Press	
'Enter'	key.	Then	change	to	a	smaller	
resolution.	

	

Note,	just	in	case!	
These	two	buttons	on	the	left-side	menu	bar	
allow	manual	access	to	files.	
Do	NOT	click	these	yet.	

	

"Questions	and	Materials"		
(holds	the	original	questions)	

	

"Answers"		
(where	your	answer	script	will	go).	

	
Need	to	draw	diagrams?	
	 	See	the	reverse	side	of	this	sheet!	

Be	sure	to	close	down	properly…	

	

On	the	left	side	button	bar,		
click	the	red	"Shut	Down"	button	
then	confirm	the	action.	

Project	contact	on	the	Web:	
TransformingExams.com	

STOP	&	WAIT!	
	

#	Apple	models	with	the	T2	chip	(2018	onwards)	need	'secure	boot'	to	be	disabled:	Hold	down	Command+R	at	
power-on.	Then	use	Utilities	>	Startup	Security	Utility.	Set	'Secure	boot'	=	'no	security'	&	'External	boot'	=	'allow'.		
This	will	not	harm	the	computer	or	put	it	at	risk.	
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Technical	Help	
Laptop	Requirements:		
Intel	64bit	processor,	1	or	more	standard	USB	Type	A	ports,	2GB	RAM,	built-in	keyboard.	
Note!	Please	create	and	use	a	practice	eExam	USB	or	attend	a	practice/preview	session	to	ensure	you	
can	boot	the	e-Exam	USB	on	your	laptop	prior	to	coming	to	the	exam.	You	MUST	print	an	eExam	
Certificate	to	use	your	laptop	in	the	eExam.	A	wired	USB	mouse	recommended	(wireless	devices	
prohibited).	Re-plug	this	in	if	the	pointer	does	not	move.	

Apple	Intel	laptops	 	 																							[Note:	most	Apple	MacBooks	with	USB-C	ports	are	not	compatible.]	
1. The	power	must	be	off:	use	Shut	Down.	
2. Now	insert	the	e-Exam	USB	stick.		
3. Hold	down	the	Alt/Option	key	while	pressing	and	releasing	the	power	button.	Keep	holding	the	Alt	key	until...	
4. The	boot	screen	appears.	Choose	a	yellow	drive	icon:	First	choice	"EFI	boot",	second	choice	"Windows".	

	

If	all	is	well	the	e-Exam	System	will	start.		
Note!	The	correct	choice	varies	between	Mac	models!	
If	you	see	"Boot	error",	please	try	again.		

Power	down	and	start	at	step	1	again	–	be	sure	to	
choose	the	other	yellow	drive	icon!	

Intel	'Windows'	Hardware																			[Notes:	Microsoft	surface	pro/book	and	Chrome	books	are	not	compatible]	
Starting	all	brands																			[Some	Win8/10	machines	require	you	to	use	SHIFT	>	Restart	to	access	USB	boot	option]	
1.	The	power	must	be	off:	use	Shut	down	(in	Win8/10	-	hold	down	the	SHIFT	key	while	selecting	Shut	down).		
2.	Now	insert	the	e-Exam	USB	stick.	
3.	Then	power	on	while	tapping	your	'one	time	boot	key'	…	until	the	relevant	menu	appears	–	then	select	the	USB.	
The	correct	'one	time	boot	key'	or	'set	up'	may	be	displayed	briefly	after	power	on.	See	list	of	common	boot	keys:	
Brand	 Model	 One	Time	Boot	Key	 BIOS	Set-up	Key	
Acer	 All	(may	need	to	disable	'quick	boot'	in	BIOS).	 F12	(Aspire:	need	to	enable	'external	

devices'	or	'boot	menu')	
Del,	F2	

ASUS	 EEE-PC,	N…,	Rog,	Infinity,	Prime,	Zenbook,	Taichi,	
Touch,	Transformer,	R509C.	(May	need	disable	'Fast	
boot'	in	BIOS)	

Esc	(must	boot	manually)	 F9	or	F2	

ASUS	 Model	numbers	starting	with	K	or	X	and	R503C	 F8	(must	boot	manually)	 Del	or	F2	
Compaq	 Older	models	or	newer	models	(see	also	HP)	 ESC	or	F9	 F10	
Dell	 Most,	including	Alienware	 F12	 F2	
Dell	(tablets)	 Venue	11	tablet	PCs	(note	venue	7	and	8	tablets		

use	micro	USB	and	need	an	adapter)		
Hold	'Volume	down'	then	power	on.		-	

eMachines	 	 F12	 Tab,	Del	
Fujitsu	 	 F12	 F2	
HP	 Most	newer	models	 ESC	>	F9	 ESC	>	F10	
Lenovo	 All						(note:	Ideapad	100s	not	compatible)	 F12	or	Fn	+	F12	 F1,	F2	
Microsoft	 Surface	(*some	not	compatible	with	e-Exam	System)	 Hold	'Volume	down'	and	power	on.	 Hold	Vol	up	&	power	
MSI	 	 F11	 Del	
NEC	 	 F5	 F2	
Packard	Bell	 	 F8	 F1,	Del	
Samsung	 Ativ	Book	2,	8,	9	 F10	 F2	
Samsung	 NC10,	Series	5	Ultra,	Series	7	Chronos,	Series	9	

Ultrabook,	NP.	(May	need	disable	'Fast	BIOS	mode')	
Esc	 F2	

Samsung	 Others	…	(May	need	disable	'Fast	boot'	in	BIOS)	 F12				(or	hold	down	F9)	 	
Sharp	 	 F2	 F2	
Sony	 VAIO,	PCG,	VGN,	e	series	 Esc	or	F11	or	Esc,	F10	or	F12	 F1	or	F2	or	F3	or	ASSIST	

(while	off)	
Toshiba	 All	 F12	 F1,	Esc	or	F2	

Diagrams	
1. In	Libre	Office	Writer:	upper	right	toolbar	and	select													(or	use	the	top	menu	bar	View	>	Toolbars	>	Drawing).	
2. The	Drawing	toolbar	will	appear	at	the	bottom	of	the	window.

	
3. To	draw	use	tools:	Pencil	'Free-form	Line'	for	free	hand	lines,	'line'	tool	for	straight	lines,	shape	tools	to	draw	

shapes,	and	'text	box'	to	type	labels.	
4. To	edit	an	object,	select	it	with										from	the	drawing	tool	bar.	Then…	
5. Use	the	'Properties'	tool	bar	at	the	top	of	the	window	to	move,	rotate,	resize	etc.	

EFI	boot	=	e-Exam	

Windows	=	e-Exam	



	
	

	

	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

Good	luck	:-)	


